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Introdução

• A edição do Painel PEMM 2022 adotará o estilo de citação criado em
2020 (“Painel PEMM (UFRJ) 2020.csl”);
• Possibilidade de citação automática (Mendeley, Zotero);

• O presente guia visa:
• Apresentar um passo a passo para utilização do software Mendeley para

citação automática (parte 1);

• Apresentar a estrutura do novo padrão de referências adotado na próxima 
Semana Metalmat e Painel PEMM 2022 (parte 2);

OBS: O formato de referências apresenta diferenças com relação ao utilizado nos
anos anteriores a 2020. Atente para o novo padrão de citação antes de realizar sua
submissão (ainda que de forma manual).
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Guia Básico para Citação 
Automática e Instalação do 
estilo de citação “Painel PEMM 
(UFRJ) 2020”

Mendeley
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Passo a passo

1. Download Mendeley Desktop;

2. Instalar Plugin de Citação (MS Word);

3. Download e Instalação do Modelo de Citação “Painel-PEMM (UFRJ)
2020”;

4. Utilização da Ferramenta de Citação;

Guia para citação automática: Parte 1 – instalação e uso
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0.1 – Cadastro de Conta – Mendeley

• O Mendeley é uma ferramenta de
propriedade da Elsevier; Caso possua
uma cadastro de usuário na Elsevier,
utilize o mesmo cadastro para utilizar
o Mendeley.

• Caso não possua cadastro na Elsevier,
acesse www.mendeley.com e clique
na opção “Create a free account”
para realizar seu cadastro;

Guia para citação automática: Parte 1 – instalação e uso

http://www.mendeley.com/


6

1 – Instalar Mendeley Desktop

• Apesar de existirem outros gerenciadores de referências, recomendamos o uso do
Mendeley como ponto de partida para todos;

• O Mendeley Desktop está disponível para download através dos links:
• Windows: https://www.mendeley.com/download-desktop-new/Windows
• Mac OS: https://www.mendeley.com/download-desktop-new/macOS
• Linux: https://www.mendeley.com/download-desktop-new/linux

• Guia de Uso (inglês): https://www.mendeley.com/guides/desktop

• Manuais em Português:
• https://www.esalq.usp.br/biblioteca/pdf/Mendeley-manual-do-usuario-2018-v.1.pdf
• http://www.eco.unicamp.br/biblioteca/images/arquivos/pdf/Tutorial_Mendeley_Pietra.pdf

Guia para citação automática: Parte 1 – instalação e uso

https://www.mendeley.com/download-desktop-new/windows
https://www.mendeley.com/download-desktop-new/macOS
https://www.mendeley.com/download-desktop-new/linux
https://www.mendeley.com/guides/desktop
https://www.esalq.usp.br/biblioteca/pdf/Mendeley-manual-do-usuario-2018-v.1.pdf
http://www.eco.unicamp.br/biblioteca/images/arquivos/pdf/Tutorial_Mendeley_Pietra.pdf
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1.1 – Mendeley Desktop (Overview)

1. Adicionar Arquivos;

2. Adicionar/Remover
Pastas;

3. Sincronizar com sua
conta;

4. Pesquisar;

5. Pesquisa na
Literatura;

6. Minha Biblioteca;

7. Grupos;

8. Painel Principal;

9. Painel de Detalhes;

10. Painel de Filtros;

Guia para citação automática: Parte 1 – instalação e uso
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1.2 Adição de Documentos

A inclusão de documentos em sua 
biblioteca pode ser feita de 3 
maneiras:

1. Arraste e solte arquivos PDF ou
pastas contendo múltiplos
arquivos para a janela do
Mendeley Desktop;

Guia para citação automática: Parte 1 – instalação e uso
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1.2 Adição de Documentos

A inclusão de documentos em sua 
biblioteca pode ser feita de 3 
maneiras:

1. Arraste e solte arquivos PDF ou
pastas;

2. Use a opção “Add Files...” ou “Add
Folder...”para selecionar um local
em seu computador e adicionar à
sua biblioteca;

Guia para citação automática: Parte 1 – instalação e uso
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1.2 Adição de Documentos

A inclusão de documentos em sua 
biblioteca pode ser feita de 3 
maneiras:

1. Arraste e solte arquivos PDF ou
pastas;

2. Use a opção “Add Files...” ou “Add
Folder...”;

3. Adicione manualmente a
referência (File>Add Entry
Manually”), preenchendo os
detalhes do documento.
▪ Útil quando não possui o PDF do

documento;

Guia para citação automática: Parte 1 – instalação e uso
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1.2 Adição de Documentos

A inclusão de documentos em sua 
biblioteca pode ser feita de 3 maneiras:

1. Arraste e solte arquivos PDF ou pastas;
2. Use a opção “Add Files...” ou “Add

Folder...”;
3. Adicione manualmente a referência

(File>Add Entry Manually”), preenchendo
os detalhes do documento.
▪ Útil quando não possui o PDF do documento;
▪ Se tiver os códigos DOI, PMID ou ArXiv ID do

documento, pode inserir no campo apropriado
e clicar na lupa para o Mendeley buscar e
preencher as demais informações da
referência;

Guia para citação automática: Parte 1 – instalação e uso
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1.3 Revisão das referências adicionadas

Sempre que adicionar uma referência, revise
os detalhes para garantir que estão corretos
e COMPLETOS;

• Muitas vezes o reconhecimento automático do
Mendeley a partir de arquivos PDF é
incompleto OU apresenta erros de
identificação;

• Caracteres especiais (ç, ã, é, ñ, л, котик, % etc)
e sub/sobrescritos (ex: H2O, °C) apresentam
comumente erros de identificação
(necessitando revisão);

• Verifique também o tipo de documento e se
todos os campos necessários para este tipo
estão completos (ano, páginas, autores...);

Guia para citação automática: Parte 1 – instalação e uso
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1.3 Revisão das referências adicionadas

Caso utilize a busca pelo DOI, PMID ou
ArXiv ID, verifique se o código
corresponde corretamente ao
documento;

• Ainda nestes casos, pode haver alguns
dos problemas mencionados
anteriormente.

Guia para citação automática: Parte 1 – instalação e uso

Sua habilidade de citar corretamente depende da
acurácia dos dados em sua biblioteca. Recomenda-se
sempre a revisão cautelosa das referências adicionadas.
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1.4 – Organize sua Biblioteca

Crie pastas e subpastas para melhor organizar suas 
referências;

• Ao contrário de pastas em seu computador, a adição de um
documento em uma pasta na biblioteca do Mendeley não
altera a localização da referência em si (funciona como uma
label/etiqueta apenas);
• Uma mesma referência pode ser adicionada em mais de uma pasta

sem risco de duplicidade e pastas podem ser deletadas sem afetar as
referências em si;

• Para adicionar uma referência, selecione a referência no
painel principal e arraste para a pasta no painel esquerdo.

Guia para citação automática: Parte 1 – instalação e uso
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2 – Instalar Plugin de Citação (MS Word)

1. Com o Mendeley Desktop
aberto, abra o menu “Tools”
e selecione a opção
apropriada.

2. O Mendeley detectará quais
processadores de texto você
possui instalados em seu
computador; as opções
disponíveis podem variar;

3. Após seleção, o plugin de
citação será instalado
rapidamente e receberá uma
mensagem de confirmação.

Guia para citação automática: Parte 1 – instalação e uso
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3 – Instalação do modelo de citação automática 
(Painel-PEMM (UFRJ) 2020)

Nome: “Painel-PEMM (UFRJ) 2020.csl”

Instruções:
1. Realizar download através do link:

Painel-PEMM (UFRJ) 2020

2. Em Mendeley Desktop, vá para o menu
“View”>“Citation Style”>“More Styles...”

3. Arraste e solte o arquivo baixado sobre a
lista de estilos aberta para instalar.

Importante: Em Idioma, selecionar
Português (Brasil)

Guia para citação automática: Parte 1 – instalação e uso

https://drive.google.com/file/d/1rK55PLe-Erd3zmQ-MbdSiY9sKxG3e-PG/view?usp=sharing
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4 - Utilização da Ferramenta de Citação (MS Word)

Após instalação do plugin de citação, o plugin “Mendeley Cite-O-Matic”
poderá ser acessado a partir da aba “Referências” no Microsoft Word
para Windows;

Guia para citação automática: Parte 1 – instalação e uso
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4 - Utilização da Ferramenta de Citação (Word-
Mac)

No Microsoft Word para Mac, a ferramenta aparecerá como um painel
separado que pode ser posicionado pelo usuário;

Guia para citação automática: Parte 1 – instalação e uso
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4 - Utilização da Ferramenta de Citação (Libre 
Office)

No Libre Office, a ferramenta aparecerá como uma barra de ferramentas
própria no topo da tela;

Guia para citação automática: Parte 1 – instalação e uso
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4.1 – Mendeley Cite-O-Matic (MS Word)

Guia para citação automática: Parte 1 – instalação e uso

Inserir Citação Selecionar Estilo 
de Citação

Inserir 
Bibliografia

Atualizar
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4.1 – Inserindo Citação (MS Word)

Posicione o cursor no local onde deseja inserir sua primeira citação e
pressione o botão “Insert Citation” na barra de ferramentas;

Guia para citação automática: Parte 1 – instalação e uso
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4.1 – Inserindo Citação (MS Word)

• A janela do editor de citação do
Mendeley será exibida, permitindo
que pesquise a referência em sua
biblioteca;

• Após selecionar a(s) referência(s),
pressione “OK” para inserir a citação.

Guia para citação automática: Parte 1 – instalação e uso
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4.2 – Edição de Citação (MS Word)

• Para adicionar outras referências a
uma mesma citação ou corrigir a
referência adicionada, coloque o
cursor sobre a citação inserida e
clique em “Edit Citation”;

• A janela do editor de citação do
Mendeley será exibida, permitindo
alterar ou adicionar novas referências.

Guia para citação automática: Parte 1 – instalação e uso
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4.3 – Inserindo Lista de Referências (MS Word)

• Após realizar a primeira citação, a
lista de referências pode ser criada
no documento.

• Para isso, coloque o cursor na
seção “Referências” do resumo
(ou a seção apropriada no
documento em que estiver
trabalhando) e clique na
ferramenta “Insert Bibliography”
na barra de ferramentas do
Mendeley-Cite-O-Matic;

Guia para citação automática: Parte 1 – instalação e uso
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4.3 – Inserindo Lista de Referências (MS Word)

• Em seguida, a lista de referências
será inserida conforme o modelo
de citação selecionado;
• As citações adicionadas

posteriormente serão adicionadas
automaticamente na lista de
referências;

Guia para citação automática: Parte 1 – instalação e uso
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4.3 – Inserindo Lista de Referências (MS Word)

• As referências são inseridas
automaticamente no estilo de
texto “Normal” do documento. De
tal forma que são necessários
ajustes ao template;

Guia para citação automática: Parte 1 – instalação e uso
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4.4 – Formatação - Lista de Referências (MS Word)

Ajustes ao Template:

• Após terminar a edição do
documento, selecione com o
cursor a lista de referências e
ajuste a formatação para ficar de
acordo com o template:

1. Alinhamento: JUSTIFICADO;

2. Tamanho da Fonte: 10;

3. Ajustar Indentação Esquerda: 0,75cm

Guia para citação automática: Parte 1 – instalação e uso

Estilo de 
texto 

“Normal”

Estilo do 
Template
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4.4 – Formatação - Lista de Referências (MS Word)

3. Ajustar Indentação Esquerda: 0,75cm

Para ajustar a indentação:
1. Selecione com o cursor a lista de

referências;

Guia para citação automática: Parte 1 – instalação e uso

1
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4.4 – Formatação - Lista de Referências (MS Word)

3. Ajustar Indentação Esquerda: 0,75cm

Para ajustar a indentação:
1. Selecione com o cursor a lista de

referências;

2. Clique nas opções de parágrafo (aba
“Home” > “Parágrafo”);

Guia para citação automática: Parte 1 – instalação e uso

2

1
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4.4 – Formatação - Lista de Referências (MS Word)

3. Ajustar Indentação Esquerda: 0,75cm

Para ajustar a indentação:
1. Selecione com o cursor a lista de

referências;

2. Clique nas opções de parágrafo (aba
“Home” > “Parágrafo”);

3. Em “Indentation”, altere o valor da
indentação especial (Hanging) para 0,75
cm.

4. Aperte “OK” para confirmar.

Guia para citação automática: Parte 1 – instalação e uso

2

3




